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In this instruction set certain DeltaCad topics will be discussed.  I suggest that before your read 
this document you should read the DeltaCad manual.  These topics will assist you in 
organizing and preparing for any drawing you plan to work on.  It is a good idea for you to have 
DeltaCad running as you read through this document.  You can then access the windows 
discussed a try hem out.  You should also have the DeltaCad manual available and review 
what is written there. 
 
Print a copy of the “DeltaCad Shortcut Keys”.  You may find it a useful alternative to selecting 
many of the functions. 
 
Start up DeltaCad and you should see the screen shown in Figure 1.  There should be a 
Toolbar at the top and a Status Bar at the bottom as shown.  If either or both is missing select 
“View” and check that “Toolbar” and “Statusbar”, located at the bottom of the drop-down list 
both have a check mark to the left of them.  If not select the ones that are not checked.  The 
bars will now be visible. 
 

 
Toolbar

Status Bar
 

 
Figure 1: DeltaCad Start-up Page 

 
The colour of the background defaults to white.  I personally like to draw on a black 
background.  If you would like to try select “Options”, then “Options” and Background Color’.  
The two selections are black and white.  DO NOT use the colour yellow for lines unless the 



2              The Sundial Primer    created by 
             DeltaCad and Your Sundial             Carl Sabanski 
 

4/10/07 

printer allows black and white printing.  Thin yellow lines are very hard to see on a white 
background and although quite visible on the black background, it will disappear on white 
paper when printed.  Yellow will work well for solid fill as long as there is dark boundary around 
the object. 
When DeltaCad starts up all the line weights set to “Normal”.  I prefer “Thin” and if you follow 
the procedure in Figure 2 the line weights for “Line”, “Circle”, “Shapes” and “Spline” can be set 
so they are “Thin” every time DeltaCad is started.  Select “Options”, then “Options” again and 
finally the item of interest.  A drop-down list will open where you can change the line weight to 
“Thin”.  You must repeat this process for each of the listed items but it only has to be done 
once.  You can still select a heavier line weight during the drawing process.  Return to the list 
and select “Default Line Weight”.  Change the “Solid” line weight to “Thin”. 
 

 
 

Figure 2: DeltaCad Line Weight 
 
Layer 
 
Layers are very important organizational tool for your drawing.  It is easy to forget about layers 
until you need them so use them all the time and the effort will pay off. 
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Think of a layer as a transparent sheet of paper.  A drawing can consist of a number of these 
transparencies.  Each transparency can contain a specific part of the complete drawing such 
as different components, text, dimensions, etc.  When you stack the transparencies on top of 
each other you can see the complete drawing.  This is how layers work.  Figure 3 shows the 
“Layer” window that is accessed from the “View” tab.  In a new drawing there is one layer to 
start with, the “default” layer.  Up to 256 layers can be used in a drawing.  They are created in 
this window.  The “Make Current” button will make the selected layer the one you will be 
drawing in.  You can access this window to change the “Current” layer or select the arrow to 
the right of the box that displays the “Current” layer.  A drop-down list will appear with all the 
layers that were created and selecting a new layer changes it to be the “Current” layer. 
 

 
 

Figure 3: DeltaCad Layers 
 
There are two button labelled “ON” and “OFF”.  The highlighted layer can be turned “OFF” or 
back “ON” by selecting the appropriate button.  All objects drawn on layers selected to “OFF” 
will not appear on the screen until the layer is turned back “ON”.  This can be very useful.  An 
“OFF” layer cannot be made the “Current” layer.  Another useful feature of using layers 
appears when printing a drawing.  Layers can be selected to be non-printing layers using the 
“Set Print Region” function and will not be printed.  A layer selected to “OFF” will print. 
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If you accidentally place objects on the wrong layer you can move them to any layer you want.  
Open the “Select” tab and select the objects you wish to move to a different layer.  In this same 
tab select the “Change layer of selected objects” button.  Choose a new layer for the objects 
and select “OK”.  They will all be moved to this new layer.  Layers…use them! 
 
Snap 
 
Snap is a function that allows you to accurately position the cross hairs when performing 
various other functions.  There are three snap modes and they can be selected from the “View” 
menu or by selecting the “Snap Mode Indicator” at the right side of the “Status Bar”.  The 
available snap modes are: 
 

• Snap to Nearest Point 
o Snap to Center 
o Snap to Midpoint 

• Snap to Grid 
• Snap Off 

 
Read about this function in the manual and learn how to use it.  It will definitely come in handy.  
Be careful about using a grid, as it might not be as friendly as you think. 
 
Drawing, View and Print Scales 
 
Learning to use the various scales is very useful but it can be a bit confusing.  Before 
examining the scales in detail let’s have a little discussion. 
 
In the “Pencil Age”, before computer aided design or CAD software was available, engineering 
and architectural firms employed draftsmen who drew all drawings manually.  Each person had 
a drafting board and a quantity of drafting tools and scales to aid them in their work.  They 
would use sheets of paper on which they would draw whatever it was they were required to 
draw.  The size of these sheets was standardized and the size used for a particular drawing 
was determined by the amount of information or detail that needed to be shown.  For very 
large designs, such as buildings, the drawings obviously had to be scaled so the entire building 
could be represented on a single sheet of paper if required. 
 
Drawing with the use of computers has not changed the requirements.  It should be known that 
using CAD software does not mean that one of a kind drawings will necessarily be produced 
faster than they would be manually.   Anyway, for us that doesn’t matter because it is fun and I 
can’t draw. 
 
Before you start your design think about what the finished drawing will be.  How large is the 
sundial?  Will it be necessary to print the sundial at full scale on a particular size of paper?  Will 
the drawing need to be scaled to show a monumental sundial?  A monumental sundial will not 
be printed at full scale and the drawing will likely show the details of its construction and 
include both linear and angular dimensions. 
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Drawings are normally made to standardized sizes.  However, there is not one set of standard 
sizes.  The following table provides examples of two common types.  There are others and you 
can create custom sizes that are only limited by the printing device you are using. 
 

SIZE WIDTH LENGTH SIZE WIDTH LENTH 
Imperial inches inches Metric inches inches 

A 7.90 10.50 A4 8.26 11.69 
B 11.00 17.00 A3 11.69 16.54 
C 17.00 22.00 A2 16.54 23.39 
D 22.00 34.00 A1 23.39 33.11 
E 34.00 44.00 A0 33.11 46.81 

 
Table 1: Drawing Sizes 

 
DeltaCad has a series of drawing layouts available that include title blocks.  These are 
accessed by selecting “File” and then “New”.  These are based on Imperial sizes and are 
shown in Figure 4. 
 

 
 

Figure 4: DeltaCad Drawing Title Blocks 
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You do not need to use one of these layouts but you have to think about paper size.  The size 
of paper you use will depend on the printer or plotter available.  Most home printers use 8.5 by 
11 inch (letter) or 8.5 by 14 inch (legal) paper sizes.  Some may also use 11 by 17 inch 
(tabloid) size paper.  Then you can move up to plotters.  Plotters can use paper that is either 
24 and/or 36 inches wide and comes in long rolls.  There are larger plotters.  Notice that the 
larger drawings listed in Table 1 will fit on either 24 or 36-inch wide paper.  When starting a 
drawing it is helpful to create a new layer called “paper”.  On this layer draw a rectangle the 
size of the paper you will be printing the drawing on.  This will set your drawing limits. 
 
Figure 5 is a photograph of an ink jet plotter.  The plotter is shown loaded with 24-inch wide 
paper and a roll of 36-inch wide mylar film is on top of it.  Mylar is a plastic material and more 
rugged than paper but also more expensive.  Print shops can usually provide you with both. 
 

 
 

Figure 5: 36-Inch Wide Ink Jet Plotter 
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Because the paper is on rolls length is usually not an issue unless you are producing drawings 
that are to be copied.  Figure 6 shows a copier that can copy in black and white, originals up to 
36 inches wide.  There are also colour copiers available as well as scanners that are this wide.  
The sheets of paper or mylar for these devices come in standard sheet sizes.  Having prints 
made once an original is available will probably be less expensive. 
 

 
 

Figure 6: 36-Inch Wide Black and White Copier 
 
You may well wonder why we are going through this discussion.  Knowing what you want in 
terms of your drawing and what you plan to do with it is necessary to determine what drawing 
and print scales you will use.  If you do not work through this you will get unexpected printing 
results.  If you are at a print shop trying to print a large drawing this will cost you money.  They 
print what you give them and it is your responsibility and not theirs to ensure that what you get 
is what you want. 
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Drawing Scale 
 
Drawing scale in DeltaCad is the same as drawing scale if you were to create a drawing 
manually using pencil on paper.  If you were manually drawing a very large sundial, say 6 feet 
square or in diameter on a piece of paper 8-1/2 inches by 11 inches, you could not draw it full 
scale.  You could draw the sundial at a scale where 1 inch was equal to 1 foot.  The sundial 
drawing would be 6 inches square or round and would fit on the piece of paper.  Think about 
what you are drawing.  What size of paper will you be printing on?  Does the print out need to 
be at full scale to create a template?  Is the object being drawn so large that it needs to be 
scaled down?  A drawing scale greater than 1 will scale the object down unless you are 
drawing in some metric scales; mm or cm.  Is the object being drawn so small that it needs to 
scaled up?  A drawing scale less than 1 will scale an object up. 
 
If the time is taken to select the appropriate drawing scale for the drawing then when it comes 
time to print the drawing the process is simple.  Just print at full scale or a print scale of “1”.  If 
the drawing scale is not set then an appropriate print scale will have to be selected.  So you 
can do it now or do it later. 
 
The drawing scale can be set when starting a new drawing by selecting “File” and then “New”.  
The “Create New File from template” will appear as shown at the left of Figure 7.  If the default 
drawing is open select “Options” and then “Drawing Scale”.  The “Set Drawing Scale” window 
will appear as shown at the right of Figure 7.  Selecting the “Drawing Scale Calculator” will 
open the window in the centre of Figure 7.  There are a number of predefined selections that 
can be made by selecting a button.  The drawing scale is displayed in the Status Bar. 
 
The base unit of measurement is 1 inch.  If the drawing scale is set to 1 the drawing will be at 
full scale and drawn in inches.  A circle 10 units in diameter is 10 inches in diameter.  Drawing 
scale is calculated as follows using the equation from the manual or the “Drawing Scale 
Calculator”: 
 
A) Drawing Scale (DSA) = Drawing units to be displayed / Distance to display the drawing units 

(in inches) 
 
B) Drawing Scale (DSB) = Drawing units to be used (Units per inch) x Actual Drawing Scale 
 
Using these two equations let’s first examine drawing at full scale in inches, centimetres and 
millimetres. 
 
a) Drawing full scale in inches. 
 

This is the easy one.  As DeltaCad’s base unit of measurement is 1 inch then: 
 

DSA = 1 / 1 = 1 
DSB = 1 x 1 = 1 
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Figure 7: DeltaCad Drawing Scale 
 
b) Drawing full scale in centimetres. 
 
 Given that 1-inch equals 2.54 centimetres: 
 
 DSA = 2.54 / 1 = 2.54 
 DSB = 2.54 x 1 = 2.54 

 
c) Drawing full scale in millimetres. 
 
 Given that 1-inch equals 25.4 millimetres: 
 
 DSA = 25.4 / 1 = 25.4 
 DSB = 25.4 x 1 = 25.4 
 
When using any of these three drawing scales numerical entries made in the Data Entry Line 
of the Status Bar will be treated as inches, centimetres or millimetres.  Printing at full scale or 
“1” will produce a full-scale drawing. 
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The drawing in Figure 8 illustrates the comparative results of drawing a 1-unit square in each 
of these scales.  The centimetre and millimetre squares are actually just scaled down versions 
of the 1-inch square. 
 

 
 

Figure 8: DeltaCow(?) – “A Whole Lotta Bull” 
 
Any other drawing scale will either scale the object up or down.  Let’s look at a couple other 
examples. 
 
a) Drawing at 1/8” = 1’.  Every 1/8” represents 1’ of the actual object.  Each inch is divided into 

8 units. 
 
 DSA = (1 x 12) / (1 / 8) = 12 x 8 = 96 
 DSB = 8 x (1 x 12) = 96 
 
 For this example and all the other inch/foot predefined buttons the numerical entries made 

in the Data Entry Line of the Status Bar will be treated as inches. 
 
b) Drawing at 50.  Every 1” represents 50 units of the actual object.  Each inch is divided into 

50 units.  The units can be feet, metres, miles, etc. 
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 DSA = 1 / (1 / 50) = 1 x 50 = 50 
 DSB = 50 x 1 = 50 
 
For this example and all the other predefined buttons with values greater than 1 the numerical 
entries made in the Data Entry Line of the Status Bar will be treated as any unit chosen. 
 
b) Drawing at 0.5.  Every 1” represents 0.5 units of the actual object.  Each inch is treated as 

half a unit and 2 inches are equivalent to 1 unit.  The drawing is twice (1/0.5) the size of the 
actual object.  The units can be feet, metres, miles, etc. 

 
 DSA = 1 / (1 / 0.5) = 1 x 0.5 = 0.5 
 DSB = 0.5 x 1 = 0.5 
 
At a drawing scale of 0.2 the drawing is 5 times (1/0.2) the size and at a drawing scale of 0.1 
the drawing is 10 times (1/0.1) the size of the actual object. 
 
For this example and all the other predefined buttons with values less than 1 the numerical 
entries made in the Data Entry Line of the Status Bar will be treated as any unit chosen. 
 
All the above example drawing scales can be selected directly from the “Create New File from 
template” or the “Set Drawing Scale” windows.  These drawing scales and others can also be 
calculated by entering the appropriate values in the “Drawing Scale Calculator”.  The “Drawing 
Scale Calculator” can also be used to determine other drawing scales. 
 
With the “Drawing Scale Calculator” a drawing scale can be determined for a variety of 
drawing units and drawing scales.  Selecting drawing units for “Inches”, “Millimeters” or 
“Centimeters” and the actual drawing scale of “1:1” will result in full-scale drawings as 
previously discussed.  Let’s look at some other examples. 
 
a) Select “Feet” as the drawing units and “1:1” as the actual drawing scale.  The “Drawing 

Scale” calculated is “0.0833”.  By selecting “Feet” each inch represents 0.0833 (1/12) of a 
unit.  If a line was being drawn, a numerical entry of 1 made in the Data Entry Line of the 
Status Bar will be drawn as a line 12 inches long.  The drawing is a full scale drawing in 
feet.  Selecting the “Yards” or “Meters” buttons and “1:1” will result in full-scale drawings in 
feet and metres.  These drawings would obviously not be printed at full scale.   

 
b) Let’s look at the example from the manual.  The drawing will be done in millimetres and the 

“Millimeters” button is selected.  The “Drawing units to be used” is automatically set to 
“25.4” as there are 25.4 millimetres in an inch.  The “Actual Drawing Scale” is set to “20.0” 
by selecting the “1:20” button.  If a line was being drawn, a numerical entry of 20 made in 
the Data Entry Line of the Status Bar will be drawn as a line 1 millimetre long.  The 
“Drawing Scale” will be: DSB = 25.4 x 20.0 = 508.0 
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To get a better understanding of drawing scale you have to try it out.  Think it through, make a 
selection and then draw a horizontal line of a known length, dimension it and print it at full 
scale.  If it doesn’t work the way you thought it should repeat the process. 
 
As was mentioned earlier, what is unique about using a computer aided design or CAD 
program is that you can draw to full scale.  At a scale of 1 to 1 or 100% your drawing is the 
same size as the actual sundial you are designing.  This is the drawing scale you should use 
when you are designing your sundial if you possible can.   
 
Remember the default scale is “1.000” and the drawing will be done in inches.  If you wish to 
draw in centimetres select the “2.54” button and for millimetres select the “2.54” button.  You 
can draw in one scale and convert the entire drawing to a different scale by entering a different 
drawing scale.  Note that drawing to full scale will affect how fonts are sized and this is 
discussed in the manual. 
 
You may think that if you are drawing at full scale there will be a problem when you are printing 
your drawing.  This is not so because when you print your drawing you can set your print scale 
so the drawing will fit on any paper size.  However, if you are planning to print a full scale 
model of your sundial all you have to do is use a print scale of “1”. 
 
Every sundial illustrated on The Sundial Primer web site was drawn to full scale. 
 
View Scale 
 
View scale does not manipulate your drawing in any way that will have an affect on the print 
out.  All it does is allow you to zoom in or zoom out of the drawing.  The current view scale is 
shown on the status bar as illustrated in Figure 9. 
 
Many times it is necessary to zoom in to work on drawing details and then back out to just 
zoom into another area for more detail work.  Some view scale functions are available in the 
“View” tab as well as the Status Bar.  The up arrow zooms out and the down arrow zooms in.  
Notice that the view scale changes in the box in the Status Bar.  Selecting this box opens the 
“Set View Scale” window as shown in Figure 9.  Here you can enter a new view scale or select 
a predefined one from a number of buttons.  A view scale of “1” shows the drawing at full 
scale.  View scales greater than “1” zoom in and less than “1” zoom out.  A view scale of “1” 
does not mean that the entire drawing will fit on the screen.  Selecting “All” from the “Set View 
Scale” window or the “View” tab will result in the selection of a view scale that will show the 
entire drawing on the screen. 
 
Notice the semi-circular arrow or “Set to previous view” button in the “View” tab.  When this 
button is selected the drawing is taken back to the previous view scale.  This can be repeated 
a number of times and is very useful.  Also note the “View objects within rectangle” button.  
This is a very quick way to zoom into a specific area by just drawing a rectangle around it. 
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Another point to note is that the view scale can be adjusted after a drawing function has been 
started.  This is also true for using the scroll bars.  This feature is very useful when it is 
necessary to zoom in to pick a particular point and then zoom out to pick a second one.  This 
can be done from the Status Bar or the “View” tab.  For example, you are in the “Line” tab and 
pick a point to start a sloped line from.  The next point is difficult to see because of a busy 
drawing.  If you choose the “View” tab you can zoom right into the second point.  Now you 
want to select the second line point but the line has disappeared.  Return to the “Line” tab and 
the line will reappear allowing you to complete the function. 
 

 
 

Figure 9: View Scale 
 
After a while the actual view scale value becomes of little use.  You just want to zoom in or out 
to whatever level allows you to do your drawing. 
 
Print Scale 
 
Once your drawing is complete you will want to print it.  If an appropriate drawing scale was 
selected this is not very difficult.  Select “File” and then “Set Print Region”.  The “Print Region” 
window will appear as shown in Figure 10.  Your drawing will appear in the small window.  The 
print scale is set in the “Print Scale” portion of the window. 
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If the “Scale” box shows a value it can be reset to “0” by selecting the “Scale to Fit Printer” 
button or by entering “0”.  The drawing will be automatically scaled to fit the size of paper 
selected for the printer.  Choose this setting if the size of the print out is not important. 
 

 
 

Figure 10:  Print Scale 
 
If your drawing is at full scale and will fit within the limits of the printer paper then select a print 
scale of “1”.  The drawing will be printed at full scale.  Choose this setting if you are making a 
template. 
 
All other values entered in the “Scale” box or selected from the predefined scale buttons will 
result in the drawing being printed at a larger or smaller scale.  Table 2 gives some examples.  
The small window will show how many sheets of paper will be required to print out the drawing.  
This will give you some idea as to whether something is not quite right. 
 
Read the manual for more information about setting up for printing. 
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Print Scale Output Larger by Print Scale Output Smaller by 

    
0.01 100x 1 Full scale 
0.02 50x 2 2x (0.5) 
0.05 20x 5 5x (0.2) 
0.1 10x 10 10x (0.1) 
0.2 5x 20 20x (0.05) 
0.5 2x 50 50x (0.02) 

 
Table 2:  Printer Output vs. Print Scale 


